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The following changes have been made to DAT/EM products between Release 8.0 and Release 8.1. Please review these 
revisions made to the software and update your software to implement changes. As always, DAT/EM welcomes 
comments and suggestions from you, our clients, so please don’t hesitate to contact our support department at 
support@datem.com or call us with your requests. 
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Operating Systems and Microsoft Updates 
DAT/EM software no longer supports 32-bit operating systems. Any reference to an OS in the remainder of this document 
refers to the 64-bit version of that OS only. 

DAT/EM Release version 8.1 is supported on the following operating system: 

• Windows 11 Professional and Enterprise. 

• Windows 10 Professional and Enterprise. 

Notes: 

o DAT/EM generally recommends installing all Windows updates; however, if you are using nVidia 3DVision and a 
Microsoft Windows 10 semi-annual channel update greater than 21H2, please check with DAT/EM to ask 
whether 3DVision still works with the newer channel update. Let us test it before you do. 

o DAT/EM software does not work with Windows Home Edition or LTSC (Long-Term Servicing Channel), formerly 
known as LTSB (Long-Term Servicing Branch). 

 

DAT/EM Software Installation 
1. DAT/EM’s installation process will now place the version number so that Microsoft SCCM inventory will show it in 

the “Installed Software Product Version” list. 

2. The installation for stand-alone MapEditor for MicroStation CONNECT has added the datsiConn.ma file and a line 
to load it into the mapEd.cfg file that configures MapEditor in CONNECT. Additionally, Capture for MicroStation 
CONNECT has the modification for its MapEditor-only .cfg file, which can be activated by the DAT/EM 
Administration Tools’ CAD Enabler. These changes are related to detecting tentative point snaps. See more 
information in the “DAT/EM Capture and MapEditor for MicroStation CONNECT (64-bit versions)” section below. 
(April 11, 2022) 

 

Hardware Locks/Dongles 
Install Microsoft Updates before applying lock reset programs. Network licensing should have the same Sentinel driver 
version on both the lock server and the local workstations running the software. 
 

1. The Thales Sentinel driver version 7.7.1 is provided with DAT/EM version 8.1. This is an update from the one 
provided in the previous DAT/EM version. (2022) 
 
Sentinel Driver on Network Lock Servers: If you have a network lock on a network server, DAT/EM strongly 
advises you to install Sentinel 7.7.1 on the network lock server to match the version on the DAT/EM workstations. 
DAT/EM provides a convenient prerequisites setup file that installs the required Microsoft C++ redistribution files 
and the Sentinel 7.7.1 driver: 

• Error! Hyperlink reference not 
valid.https://datemsystems.com/down/Datem_PreReqs_blt_12_02_2021.exe   

• This is www.datem.com > Support > Downloads > Prerequisites > “DAT/EM Prerequisites … Sentinel 
7.7.1 …” 

• Answer “Yes” to Sentinel’s firewall question. 
• Reboot the server after installation. 

Please do not skip the update for the network lock server. The newer Sentinel driver works better, and the 
best communication can be expected when the Sentinel versions match. 
 

 

https://datemsystems.com/down/Datem_PreReqs_blt_12_02_2021.exe
http://www.datem.com/
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**New Again!** DAT/EM Virtual Reality (VR) 
DAT/EM Virtual Reality (VR) in its previous form was discontinued, but it’s now back and better than ever! It now works 
with Meta Quest® 2 headsets only. It is expected to work with future Meta Quest Pro and Meta Quest 3, but please check 
with DAT/EM for more current information when these headsets become available.  (October 12, 2022) 

What the new DAT/EM VR software does: 

• It shows the Windows Desktop inside of VR on a virtual screen. 

• It shows DAT/EM applications on that virtual screen in stereo. No other software does this properly. 

• You can control Summit with the VR controllers. Point at the Summit view and use the joysticks to control (x,y,z). 

• Load Terrain Projects. The points are shown in a full 3D view along with the virtual screen. You can fly around 
using the VR controllers. 

• You can collect features on the points using superimposition or with simple drawing tools. You can point at points 
using a virtual wand and have the cursor automatically snap to the points. In this way, you could collect a building 
roof line, for example, by pointing at the corners of the building and picking. 

DAT/EM software engineers are pleased with the resolution of the Meta Quest 2 headset. If you tried DAT/EM VR in years 
past, you may want to have another look now. We’d love to read your review sent to support@datem.com. 

If you have a Meta Quest 2 headset and would like to try DAT/EM VR, contact support@datem.com for setup information. 

   

Stereo Viewing Devices and Drivers 
Please contact DAT/EM Support if you have any questions about setting up nVidia 3DVision, buying 3DVision-compatible 
monitors, or setting up any other brand of stereo monitor. There is too much information to include here. 

 

DAT/EM Administration Tool 
The following changes have been made to the DAT/EM Administration Tool: 

 
1. The Sentinel option has a new Reset Sentinel installed state button. This requires administrator privileges 

since it modifies the registry at the Software level.  
 
The button function clears DAT/EM’s registry key that stores the last Sentinel version and installation date. This 
key is used to prevent multiple runs of DAT/EM Setup or DAT/EM Prerequisites (“Setup”) from launching multiple 
installations of the same Sentinel hardware lock driver version.  
 
As an example of use, let’s say you had accidentally answered “No” to modify the firewall during the Sentinel 
installation the first time you ran Setup. You have since used Windows Add/Remove Programs to remove the 
Sentinel Protection Installer, and now you want Setup to relaunch the Sentinel installation. Windows Add/Remove 
Programs will not change DAT/EM’s registry key, so if you don’t use this new button, Setup will continue to avoid 
reinstalling Sentinel. Use the button first, then relaunch Setup (either DAT/EM version Setup or Prerequisites) to 
activate Sentinel installation.  (June 27, 2022) 
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New Reset Sentinel installed state button to allow multiple installations of the same Sentinel driver version 

 

Point, Image, and Vector File Formats (Affecting Multiple DAT/EM Applications) 
DAT/EM applications read a variety of file formats that contain points, images, and vectors. The code is shared among 
several DAT/EM applications, so when one can read a certain format, others can, too. The following changes have been 
made to the list of supported formats: 

1. “Adobe Deflate” image compression is now supported in Summit and Image Creator. (October 19. 2021) 

2. The .cog file extension is added to image extension list shown in various image browse dialogs. Previously, the 
.cog format was technically supported, but the browse dialogs did not display them for easy selection.  (June 2022) 

 
.cog file extension is added to the image extension list in various browse dialogs 

 

3. We received a TIF DEM file made by Safe Software FME Workbench. The file contained a data type that was 
previously unsupported in DAT/EM image readers. This format is now supported.  (August 25, 2022) 

4. The Blue Marble vector file translation library has been updated. Previously, it would often crash on reading 
MicroStation .dgn files, for example, in Summit’s DAT/EM Drawing Objects or Ortho+Mosaic’s vector file input 
dialog. The files that crashed previously now import correctly.  (October 29, 2021) 

5. DAT/EM applications did not correctly handle LAS/LAZ files if they contained additional information in the 
"Minimum PDRF Size" field in the point format, which is now allowed in LAS/LAZ format. This is any custom 
information that a third-party vendor wants to write to the LAS/LAZ along with the standard defined point format. 
This additional information may exist in some TerraScan output files. Now DAT/EM will read the points from the 
files correctly; however, if DAT/EM rewrites the file, such as with LandScape or Point Translator, the additional 
third-party information will not be carried forward to DAT/EM’s output files.  (July 12, 2022) 

 

DAT/EM Keypad 
No changes have been made to the DAT/EM Keypad products, except for new keywords mentioned in the particular 
product sections below. 
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Coordinate Transformations and Elevation Database 
There have been no changes to the elevation database installation file built in 2015 found here: 
http://datemsystems.com/down/SetupElevationModels%20blt%2003%2015%202015.exe. If you already installed that file 
with previous DAT/EM versions, you do not need to reinstall it. Any changes have been added to the DAT/EM setup 
installation, so that you do not need a new, separate Elevation Database file. 

There are newer files and changes, but they are all included in the main DAT/EM software installation: 

1. A newer version of the Blue Marble coordinate conversion code library is incorporated. (Nov. 10, 2021) 

 

DAT/EM Stereo Viewer 
The DAT/EM Stereo Viewer was added in DAT/EM version 7.6. For instructions on how to use the Stereo Viewer, please 
see the Stereo Viewer Operation Manual available from www.datem.com > Support > Downloads > Manuals > Stereo 
Viewer. There have been no specific changes to the DAT/EM Stereo Viewer for v.8.1; however, any of the general image 
file format changes listed above may apply to it. 

 

Summit Evolution 
The following changes have been made to Summit Evolution (Summit) and the applications that are provided with it.  

 
General Summit Evolution Subjects 

1. TIN and control compare is a new tool on Summit’s Tools menu. It is used to create an NSSDA (U.S. National 
Standard for Spatial Data Accuracy) report. It creates a TIN surface from the objects currently in superimposition 
(SI), calculates the distances between the surface and the control points in a DAT/EM control (.con) file, and 
outputs the distances into an NSSDA-style report. (August 23, 2021) 

  
The tool uses the objects currently in superimposition (SI) as the CAD objects. It takes a Summit control file (.con) 
as control point input. 

To use: 

http://datemsystems.com/down/SetupElevationModels%20blt%2003%2015%202015.exe
http://www.datem.com/
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a) Adjust SI to show those objects that should be considered as data for the TIN. 

Remember that it must be showing in SI in order to be used, and everything in SI is used. 

• Polylines or “linework” in SI are used as breaklines.  

• Points are used as ground elevation points. 

• AutoCAD Blocks and MicroStation Cells are broken down into vector components to 
display in SI, so be aware that every vector of the block/cell is treated as ground 
elevation input. That is, if the block/cell is a large circle, it will be treated as a large, 
circular, flat area along the circle. If the block/cell does not have a point or vector in the 
center of it, another object on top could override the elevation at the block/cell insertion 
point. If necessary, use a version or copy of the block/cell that is represented by a point 
object or is sized quite small. 

Do not display ground control blocks/cells/points that were placed automatically at the ground 
control coordinates. If they are part of the TIN, they will create zero distance between the surface 
and every control location, because they are at exactly the same coordinates. They will produce 
an artificially perfect (and incorrect!) report. 

Do not display layers that contain off-the-ground objects such as building rooftops or boundaries. 

Turn off SI Clipping in the SI source and turn off any layers/levels that do not define ground 
elevations: 

• In MicroStation, use SI SETTINGS to uncheck Clip and uncheck Show all levels in SI. 
Then turn off the levels that do not define ground elevations. 

• In AutoCAD, use SI SETTINGS to uncheck Clip SI and check on those object types that 
should be considered as input for the TIN generation. Freeze or turn off any layers that 
do not define ground elevations. 

• In ArcMap, use DAT/EM Systems Options > SI > uncheck Clip SI. Then uncheck any 
non-ground layers in the Table of Contents. 

• In Global Mapper, select SI Settings from the DAT/EM toolbar and uncheck Clip. 

b) Locate or prepare a control .con file. If it is to be a different control file than the .con that’s already 
attached to the Summit project, then use Summit > Edit > Control (Control Editor) to import a 
control list using the Control Import Wizard. The .con file can be, but is not required to be 
attached to the current Summit project. 

c) Start Summit > Tools > TIN and control compare. 

d) Use the SI Update button. This redraws SI to make sure it is current. Review the number of 
objects reports that appear in the dialog to make sure there is something in SI. 

e) Browse for the .con file, make settings, and set the name and location of the output file (report). 

f) Select Generate to make the report. 
 

2. Summit Evolution was not properly linking the codex for Adobe Deflate compression. Images with this 
compression type would appear completely black. This is fixed. (October 19, 2021) 
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3. Summit’s Tools > Measurements dialog had some incorrect text labels. It has the following changes: (January 4, 
2022) 

 

 

“Altitude” is now “Angle to XY plane” 

“Slope” is now “Slope in XY plane” 

Length XY is now “Length 2D” 

“Distance XY” is now “Distance 2D” 

“Num points” is now “Number of Points” 

 
 

4. Summit > Imagery > Epipolar Generation has a substitute method to generate epipolar images for aerial 
projects and some other stereo project types. It now uses a polynomial fit of the 2D original pixels to epipolar. 
(Satellite RPC epipolar generation has not changed.) (Approximately February 1, 2022) 

5. When Capture for MicroStation performed a “Move to Tentative” point that was picked outside the current model, 
it would change models in Summit, even if Summit > Tools > Options > Project > “Automatically load next 
model” was off. Now it will respect Summit’s setting and keep the current model open if necessary. (July 18, 2022) 

6. There is slightly modified communication for the Stealth Z tabletop mouse a new checkbox in Summit > Tools > 
Options > Input Devices > Hand Wheels for legacy Stealth-brand handwheels. Uncheck the setting for tabletop 
Stealth Z models. Check on the setting for Stealth handwheels. Both the tabletop Z and Stealth handwheels need 
Stealth Z Mouse checked on. The new checkbox is off by default; Stealth handwheels users will need to check 
on the setting after installing version 8.1. (August 31, 2022) 

 
New checkbox: Uncheck for tabletop Z models (shown), check for Stealth-brand handwheels 
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7. Summit > Tools > Google Maps has been replaced by a “new Google Maps tool”, which uses the newest CEF 
(Chromium Embedded Framework) version. There will no longer be a message about an unsupported browser. 
The “old Google Maps tool” stopped working in early 2022. This was due to a change by Google, so can’t be fixed 
in any older DAT/EM version. The first beta that contains the new tool is v.8.1 beta dated 22 March 2022. (March 21 
and 29, 2022) 

DAT/EM software installation will now place several subfolders and files in a new folder called “C:\Program 
Files\Datem Software\CEF”. 

The new version works similarly to the way it did before, except now is has two windows instead of one. One 
window has the Google Maps view and the other has the coordinate system currently representing the Summit 
Ground coordinates, which is needed to translate back into WGS84 for Google Maps. If the input coordinate 
system is set in Summit > Orientation > Coordinate Conversion, or the output system when a coordinate 
conversion is active, it will match automatically to that system. If it isn’t set yet, then you may use the 
Coordinates button in the second Maps window to set it. 

 
The new Google Maps tool has two windows, Datem Map Browser and Maps. 

 

 

 

If the Datem Map Browser shows the final ascent to Denali in 
the Alaska Range, first move the Summit cursor a little. If the 
mountain remains, it means the coordinate system is not set. 
You may use either the Coordinates button in the smaller Maps 
window or Summit > Orientation > Coordinate Conversion to 
set the input system represented by the ground coordinates in 
the Summit project.  
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Terrain Project Tools (except Point Cloud) 

8. Terrain Projects and Terrain Project-related subjects (except Point Cloud) have the following changes. Note: Point 
Cloud application items are in the next section of this document. 

a. The Terrain Project generator tool correctly applies the compression setting. Previously, the compressed 
.vrldr might not be readable. (2022) 

Point Cloud Application 

9. Point Cloud has the following changes: 

a. The Mesh View tool has been removed pending review of its code rights. (July 2022) 

 
Superimposition 

10. Superimposition (SI) has the following changes: 

Additional CAD/GIS-specific SI changes may appear the particular Capture sections. 

a. The SI CAD command and messages line and active layer display have a new option to display above 
the cursor. Select Summit > Tools > Options > Main Text > Location > Above Cursor:  (November 29, 
2021)  

    
Additional Above Cursor setting for the CAD commands/messages and active layer 

b. SI line patterning of patterned CAD/GIS lines previously patterned lines well if they were in the Y direction 
on screen (Summit view), but not if they changed in X. This is fixed so that patterns will look good in 3D 
overall. (January 10, 2022) 

 
Aerial Projects (traditional and UAS) 

11. Aerial projects (traditional and UAS) have the following changes: 

a. In aerial projects, Summit > Orientation > Import Matrix Exterior > ORI file could return “nan” (Not a 
Number) for some angle conversions. This was related to trigonometry functions that require input values 
between 1 and -1, but due to computer rounding methods expressed in the ORI file values, were given 
input values such as 1.0000000000567, which is slightly outside the limits. Such values will now be 
forced to be within the limits to avoid placing “nan” in the exterior orientation angles. (November 3, 2021) 

 
Satellite RPC Projects 

12. Satellite RPC projects have the following changes: 

a. Add Multiple in the satellite RPC Project Edit dialog is fixed. Previously, it would not find any images in a 
folder tree, so that Add (single) had to be used multiple times instead. Now Add Multiple can find all 
image and RPC pairs in the folder tree you specify. (September 19, 2022) 
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Button Manager  

13. Button Manager (used by both Summit and LandScape) has the following changes: 

a. In a Button Manager User Cad button, a semi-colon ; character will now pass through to CAD 
unchanged. Previously, it would be replaced by a return character. This change is important to be able to 
send multiple commands to MicroStation in the same string; MicroStation uses ; to separate multiple 
commands on its command line. For example, to set the level, weight, color, and line code, and to start 
the AUTOARC command, this User CAD button string would work equally from the MicroStation Key-In 
Browser or a User Cad button in the Button Manager being use with Capture for MicroStation:  (May 23, 
2022) 

lv=tree;wt=ByLevel;co=ByLevel;lc=ByLevel;autoarc 

The ; after the final command is optional. Note that the string of multiple commands still requires {RET} to 
separate the commands when set on the DAT/EM Keypad. 

 
Project Viewer / Ortho+Mosaic  

14. Project Viewer / Ortho+Mosaic has the following changes: 

a. Ortho+Mosaic’s Options > General tab > Rotation setting now allows rotations in tenths. Previously it 
was in whole degree units. (August 30, 2022) 

 
b. Ortho+Mosaic Polygon Vertices dialog that edits existing boundaries has new Rotate and Move buttons. 

To use:  (August 30, 2021) 

• Click on the boundary to edit. Make sure the vertices are marked, which indicates it is selected. 
The Polygon Vertices dialog will appear. 

• If you intend to rotate the boundary and wish to rotate it about any vertex other than vertex 1, 
select the rotation origin vertex number in the list. If no selection is made, it will use vertex 1. 

• Select either the Rotate or Move button, depending on which tool you’d like to use. 

• Use the up and down arrow keys on the keyboard to adjust the rotation/position. If rotating, it will 
rotate about the selected rotation origin vertex or vertex 1, if no selection was made. 

• To choose a different rotation origin vertex, first select the Rotate button again to toggle off the 
rotation tool. Then select the new rotation origin vertex from the Vertex list. Finally, select Rotate 
again to reactivate the rotation tool using the newly selected origin vertex. (The rotation origin 
vertex may not be changed while the tool is active.) 

• To stop using Rotate and start Move (or vice versa), click on the active tool’s button again to 
toggle it off, then select the other tool’s button. 
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• To stop rotating/moving and finish, select the “x” button to close the Polygon Vertices dialog. 
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LandScape 
Landscape has the following changes: 

1. The Color Classify tool has been replaced with an improved version. The filter is still located in the same place in 
the Filter Points tool list: (December 14-16, 2021) 

 

• Description: The Color Classify filter classifies points based on point colors selected by the user. 

• Input Values: The Source Set selection set identifies points that will be handed in to the filter as potential 
candidates for classification. 

The Target Class will be assigned to points that meet the filter criteria. Another option is to delete those 
points, but that is rarely used. 

The  button is used to interactively select sample colors that the filter will attempt to match. It acts as a 
toggle. Pick once to begin selection, a second time to stop selection. When colors are selected the Hue, 
Saturation, and Value data fields will be filled in to give an idea of the colors selected. The Status area 
will contain prompts. 

The   button may be used to clear the selected colors. 

The Tolerance value allows the filter to include colors that are similar to those selected in the group of 
point colors to be reclassified. The higher the Tolerance value, the wider the range of matching colors. If 
Tolerance is set to 0 then only points with colors that exactly match a selected color will be modified. 

• Notes: 1) The colors must be built into the points file format and not added by loading an orthophoto 
image into LandScape. LAS formats 2 and 3 as well as BIN all support embedding color in the points. 2) 
The selected colors will be stored for the next run, but there is limit of storing 2047 colors. 
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2. Bare Earth Cloth is a new bare earth filter tool. It identifies bare earth points by simulating draping a cloth over 
the point cloud and comparing the elevation of the cloth to the points in the cloud. It is based on the 2016 paper 
“An easy to use Airborne LiDAR Data Filtering Method Based on Cloth Simulation” by Wuming Zhang, Jianbo Qi, 
Peng Wan, Ongtao Wang, Donghui Xie, Xiaoyan Wang, and Guangjian Yan. It is much easier to use, faster, and 
produces better results than the original Bare Earth filter, which is still included with LandScape.  (March 1, 2022) 

 
Settings for the new Bare Earth Cloth filter 

Bare Earth Cloth settings are as follows: 

• The Selection Set identifies points that will be used as input for both the Cloth surface and the target 
points. 

• New Class identifies the new class of points identified as bare earth. 

• Cloth Resolution is the size of the grid that will be used to create the cloth. Each file’s surface will be 
broken down into Cloth Resolution-sized areas with a point in each area. This setting is sensitive to the 
density of the original file. If the Cloth Resolution is too small, then Bare Earth points may be found on 
the tops of large buildings. If it is less than the density of the points in the file, then cloth creation may fail. 
If this setting is too large, then points near vertical changes, such as walls, will be missed. A reasonable 
rule of thumb is set it to the square root of the density or higher. 

• Preview  may be used to try different settings on the data set. 

• Max Iterations identifies that maximum number of times the cloth surface will be adjusted attempting to fit 
it to the surface. During the adjusting process, cloth points that have not yet penetrated the original 
surface are adjusted up and down based on the height of their neighboring cloth points until they have 
found a point below the surface of the original surface. At that point their elevation is locked and will not 
be further adjusted. If Max Iterations is exceeded, then the filtering attempt has failed, in which case you 
may review the Cloth Resolution relative to the point density. 

• Classification Threshold is the maximum vertical distance a surface point may be away from the cloth to 
be considered bare earth. It is not used in the creation of the cloth surface. The Save cloth surface to 
file setting may be used to save the cloth surface as a .las file. The new file will be in the same folder as 
the original file and have the same name with _cloth.las on the end. If a file with the same name already 
exists, it will be deleted.  (March 1, 2022) 
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3. Merge ASCII is a new Interactive Point Edit tool. It imports points from an ASCII (text) file into one or more files in 
the active project.  (March 15, 2022) 

 
New LandScape Interactive Point Edit Merge ASCII tool 

To use Merge ASCII: 

• For this command to work, the LandScape project must already contain a points file (such as a .las 
file) in the same coordinate space as the points in the ASCII file. 

• The input file must be ASCII text, but may have any file name extension. Default extensions are .txt 
and .csv.  

• With the exception of any comment lines, the file must have one point record per line. 

• Each point record in the ASCII file must have X, Y, and Z values. 

• A Class value may be included, but is optional. 

• Delimiters is set to the character that separates fields in the record line. 

• Comments is set to a character that indicates a comment line. If this character is found at the 
beginning of a line, the line will be ignored. 

• Drag and drop Field Name values to reorder the format list to match the order of information in the 
ASCII file records. Note that X, Y, and Z must exist and must be checked, but may be in any order 
that matches the order in the ASCII file. Class is optional and is checked and ordered only if it is 
included in the record. 
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• One or more unused columns may be skipped using the Skip button. 

• The Reset button may be used to reset the format to default values. 

• As with all Interactive Editing tools, the changes must be saved using the save  button. 

• The Merge button imports the points into the project. Each point will be added to the current project 
file with the nearest center point.  

• Troubleshooting: If no points are added, verify that the coordinate system of the points in the ASCII 
file matches the one used in the LandScape points file(s). Verify the format settings against the ASCII 
input file. The number of non-skipped fields must match.  

4. Noise Classify is a new tool. It is more useful for image correlation point than for points acquired by lidar. It is 
designed to clean up image correlation data in areas where the correlation is likely to fail, such as on water and 
snow areas. Such areas usually have few points, and some of those points may have very different elevation 
values. The Noise Classify filter uses those features to identify points in those areas with extreme elevation 
changes. It may also be used to identify outliers in otherwise smooth surfaces. 

 
New Noise Classify tool for autocorrelated data 

The settings are as follows: 

• Cell size: The area to be filtered is broken into rectangular Cell Size areas. The mean(average) 
and median elevation values are calculated for the cell and the elevation of each point is 
compared to these values. Cell size will depend on the project. 

• Classification Threshold: Any point with an elevation greater than the Classification 
Threshold from the cell’s mean or median values is reclassified to the New Class setting. It may 
be set to 0 to classify all points found in sparse areas. 

• Only sparse cells: If this is turned on, then only areas with a density less than Density scale 
(see below), the density of the overall area, will be checked. It is on by default. 

• Density scale: This value is used to scale the overall area’s density before the density 
comparison is performed. It should be between 0.01 and 1.0. Smaller values would include more 
areas to be checked for classification. Larger areas would include fewer values. 
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5. Add densified points to surface has been added to Interactive Edit Breakline. It creates new points by 
densifying the breaklines and adding the new points to the open points file with the nearest center point. It also 
saves the densification to the vector file that contains the breaklines. An example of use is to densify breaklines 
along the tops of retaining walls, add the new retaining wall points to the surface set, and use the surface set later 
as input for contour generation.  (March 23, 2022) 

 

 
To use Add densified points to surface,  

• In the Interactive Breakline tool, check on Add densified points to surface.  

• Choose a Dense points class to receive the new points.  

• Set Dense points scale to control the density of the new points. The default density is one fourth 
of the project point density. This is normally approximately double the point density along a line. 
For more points, set the value less than 1.0. The smaller the value, the more points will be 
inserted. Values greater than 1.0 generate fewer points.  

• The vector file (source of the breaklines) will be saved with point edits. If untitled, a prompt for a 
new filename will be given. 

6. The (original) Bare Earth tool could cause a crash in some error cases. This is fixed.  (August 22, 2021) 

7. Vectors loaded from vector files and displayed in LandScape could flicker. This is fixed. (November 1, 2021) 

8. The Breakline Filter command working on a selection set involving vector boundaries could delete all points. 
This is fixed.  (November 10, 2021) 

9. The Interactive Point Edit dialog has a faster way to load its child dialogs, which are the dialogs for the individual 
tools. In the past, both dialogs could take up to 1.5 minutes (on a DAT/EM development machine) to launch, 
depending on the system state. The slowdown was related to building all of the child windows at one time. The 
new method is to only create one child dialog when the user chooses that specific tool. It may take the child dialog 
approximately 10 seconds to appear if the system is operating slowly, but that is still much improved.  (March 15, 
2022) 
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DAT/EM Capture for ArcGIS - ArcMap 
This version is compatible with ArcGIS ArcMap 10.0 (service pack 4), 10.1 (service pack 1), 10.2.x through 10.8.x with release 
dates up to October 2022. Please ask DAT/EM Support about ArcMap service packs released after October 2022. 

This version may be compatible with ArcGIS 9.1, 9.2, 9.3 (service pack 1), 9.3.1(service pack 2). BE ADVISED: Testing no longer 
occurs for DAT/EM Capture with ArcGIS 9.x. It still installs for it and no code has been removed, so you may use 9.x as long as it 
continues to work for you. Any issues will not be corrected. ArcGIS 9.x support may be dropped completely in a future release. 

DAT/EM Capture for ArcGIS has the following changes: 
Capture for ArcGIS (ArcMap) 

1. Connect Lines is a new tool used to connect one or more polylines to create a new polyline or polygon, 
depending on the target layer selected. If the target layer contains fields with the same name as the source layer, 
the contents of the fields will be copied to the new feature. The copy will take place in order of selection, so if all 
objects contain the same field name, then the object selected last’s value will be the value stored in the new 
feature. (August 23, 2021) 

The keyword to use on the DAT/EM Keypad or a Button Manager button is: ConnectLines 

On the DAT/EM Systems Options > Edit Tools page, select whether to keep the original polylines. 

 
Missing the new toolbar icon? Ask support@datem.com for help. We know a trick to get it to show up! 

To use: 
a) Start editing. 

b) Verify that the lines you want to connect are already 3D snapped to each other’s endpoints. 

c) Set DAT/EM Systems Options > Edit Tools > Keep original polylines as shown above. 

d) Select a target layer. 

e) Select the Connect Lines tool shown above or start it with the ConnectLines keyword. 

f) Select the end of the first polyline you would like to connect.  

g) Select the start of the next line to connect. The tool will drive Summit to the end of that line. 

h) Continue selecting the start of any additional lines to connect. A line may only be selected once. 

i) Cancel after the last selection. The new polyline or polygon will be made. The original polylines will be 
deleted only if the Keep original polylines setting was unchecked. 

mailto:support@datem.com


DAT/EM Systems International RELEASE 8.1 Release Notes 
 

Page 18 of 50 
 

2. The FeatureShift keywords were not working from the DAT/EM Keypad or buttons. These are fixed. (October 11, 
2021) 

3. The Target keyword to set a feature class subtype in preparation for drawing was not working if another subtype 
of the same feature class was already active. For example, if these two Keypad keys were used in order (without 
a different feature class being set in between): . (November 2, 2021) 

Target FeatureClass:Subtype1 CreateNewFeatureTask draw PointToPoint 

Target FeatureClass:Subtype2 CreateNewFeatureTask draw PointToPoint 

…and drawing started, it would still be drawing on Subtype1. This is fixed 

4. There is a new Display CAD files setting in the ArcMap-side DAT/EM Systems Options dialog > SI settings page. 
When on, it will send ArcMap’s CAD reference files, such as referenced DWGs, into superimposition. It is off by 
default.  (September 7, 2022) 
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5. The Visit tool for ArcMap has the following enhancements: 

a. Previous and Next keywords will move the highlight to the next or previous list item in Visit. Note that 
Next also works in Airfield3D to move to a next obstacle in an obstruction area; the same keyword now 
works to move to the next Visit item. Previous is new.   (2022) 

b. Visit has a new user option to Select objects on move. Check this on if you intend to edit the visited 
object. It will select the object at the move location, so that it is ready to receive the edit. Hint: It is 
possible to run Visit and Field Update at the same time; this automatic selection makes it easy to “Apply” 
immediately in Field Update after Visit moves to the object.  (March 2, 2022) 

 
Visit’s Select objects on move option 

  
Location of Visit’s Options button (yellow highlight) and object selected on move (cyan highlight) 
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c. Visit has a new option to move to the center (center of gravity) of an object. Previous options to visit only 
the first vertex or every vertex are still present, but their checkbox has been changed to Shape points 
options. The settings are found in the Visit Select Input dialog. (October 28, 2021) 

  
Visit’s new Center option, with choices moved to Shape points 

 

d. Visit has a new option to move to a list made up from ArcMap’s currently selected object(s). Before using 
this option, select one or more objects in ArcMap. When Visit starts and shows its Visit Select Input 
dialog, the number of selected objects will be displayed next to the new Selected option. To use it, check 
on the option and then select the Number to Add > All button. (May 17, 2022) 

 
New Selected option in Visit for ArcMap 

Note that this option can interact with the new Select object on 
move setting shown in item 5.a on page 19 above. If Select 
object on move is on when using the Selected option, the Visit 
list will remain intact for the originally selected objects, but the 
original selection will clear when it moves to an entry in the list 
and selects the object at that location. If you want to retain the 
original selection instead, turn off Select object on move.  
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Airfield3D in Capture for ArcMap 

6. Airfield3D in Capture for ArcMap with Summit Professional Edition has the following changes: 

a. The tool to output the surfaces to the ObstructionIDSurface layer could make additional polygons that did 
not belong to the currently (correctly) displayed surface set. This is fixed. (October 7, 2021) 

b. The new “NATURAL_HIGHPOINT” spelling added in the 18b “Change 1” is now accepted as a natural 
feature Obstacle Type. The older “NATURAL HIGH POINT” spelling is still accepted as well for 
backwards compatibility with pre-Change 1 FAA documentation. (October 25, 2021) 

c. There is a new option for the 18b surfaces to merge the conical and horizontal surfaces so that there is 
only one merged conical and one merged horizontal per airfield. This will have a noticeable effect only 
when there are two or more runways. When off, there is one conical and one horizontal per runway. 
(November 18, 2021. Between December 1, 2021 and February 1, 2022, if the new merge surfaces checkbox was on and the Insert 
Surfaces tool was used, it would make a Conical surface polygon with an extra Horizontal surface polygon as an interior ring; this 
was fixed February 1, 2022 to be included in any beta February 2, 2022 or later.) 

 
New Merge Conical and Horizontal surfaces setting for the FAA 18B surfaces only 

   
Merge Conical and Horizontal surfaces off (left) and on (right) 

Note! These merged surfaces will be duplicated for each runway written to the ObstructionIDSurface 
layer; the user will need to remove the duplicates. Select and delete the additional copy or copies. Fixing 
this would require changing the entire architecture of Airfield3D, which we do not plan to do. The user will 
need to delete duplicates in trade for having this new merge setting. 

Further Discussion on Merged Surfaces: One Airfield3D client asked for this option to satisfy his 
customer and to match another competing software’s setting. Another client reacted to it saying, “I had 
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this discussion 12 years ago with the FAA and Mark Howard at the NGS. I was told quite explicitly that 
these surfaces should never be merged. FAR77 specs indicate the horizontal/conical surfaces should be 
merged, but never 18B.” For the moment, our advice would be to be very sure you want the surfaces 
merged before setting the option on and to know exactly why you want them merged. Please send your 
opinions and comments to support@datem.com.  

d. There is a new tool to build the Light Signal Clearance Surface (LSCS) Surfaces. These are based on 
FAA documents such as: Advisory Circular 150-5340-30J 
https://www.faa.gov/airports/resources/advisory_circulars/index.cfm/go/document.current/documentnumb
er/150_5340-30, Engineering Brief number 95 
https://www.faa.gov/airports/engineering/engineering_briefs/media/eb-95-papi-vgsi.pdf,  (January 24, 2022. 
The January 24, 2022 version had the surface direction backwards, there was an error in the slope in the second half of the surface, 
and it did not offer to export the light surfaces to the ObstructionIDSurface layer. Fixes for these problems are dated January 28 and 
February 1, 2022. Any beta February 1 [02_01_2022] or later contains the fixes. Testing on the February 1, 2022 beta showed a 
problem with the Surface Insert tool, which is being fixed the same day, with fixes expected to be included in any beta dated 
February 2, 2022 or later. The PAPI Obstacle Clearance Surface OCS will be added at a later date.) 

 
PAPI OCS/LSCS Options dialog with ArcMap Attributes 

Using the APAPI OCS/LSCS Options Dialog: The PAPI OCS/LSCS Options dialog is launched using 

the  button from the Airfield3D dialog on the ArcMap side. Note: OCS surfaces are not implemented. 
If you need them, please contact DAT/EM Support. 

mailto:support@datem.com
https://www.faa.gov/airports/resources/advisory_circulars/index.cfm/go/document.current/documentnumber/150_5340-30
https://www.faa.gov/airports/resources/advisory_circulars/index.cfm/go/document.current/documentnumber/150_5340-30
https://www.faa.gov/airports/engineering/engineering_briefs/media/eb-95-papi-vgsi.pdf
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The dialog displays points found on the NavaidEquipment layer with the Lighting Type attribute set to 
either PAPI2, or PAPI4. The points are matched to their corresponding runway centerlines using the 
Runway End ID attribute. 

There are two ways to control the visibility of the PAPI LSCS surfaces on the ArcMap side. The list 
contains a checkbox that may be used to turn off individual LSCS surfaces. The Show PAPI surfaces 
checkbox may be used to turn off all LSCS surfaces. It is also the only setting that is saved between 
Airfield dialog launches. Light Width and Angle settings are reset to default values when the Airfield3D 
dialog is closed. 

You may drive to an individual point by double clicking in the ObjectId column. The Light width column 
controls the width of the light bar which is centered on the NavaidEquipment point and perpendicular to 
the centerline. The Angle column controls the surface angle. Click in either of these columns to edit their 
values. Changes to all settings may be applied using the Apply button. 

A single runway centerline may have multiple light bars on either side of the runway. 

The Summit Airfields dialog may be launched using the Airfields Select List  button on the 
Airfield3D toolbar (Summit side). The OCS/LSCS surfaces will contain LSCS in the Spec column and 
their corresponding runway end in the Name column. They may be turned on and off using checkboxes in 
the On column. 

 

 

 
Summit’s Airfield3D toolbar 
Airfield Select List option 

 

 
Summit-side Airfields Dialog 
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Airfield3D Surface Insert tool showing new LSCS surface options 

 

e. Point Surface Intersections is a new option offered in the Measure Status tool. It displays all the 
surfaces that a point intersects as well as the elevation of each surface at the point. It is designed to help 
understand reporting for points that exist in ambiguous areas where there are multiple surfaces at the 
same (x,y) location. Since reporting is done on only one surface and depends on the current setting for 
Follow lowest surface at the time of the report, it can help answer questions about why a point was not 
reported on the higher or lower surface.  (April 14, 2022) 

To use: 

• Check on Follow lowest surface in the FAA 18B Options. It is only available when is 
setting is on. 

• Start the Measure Status tool. Choose runway and surface display as desired. 

 
New Point Surface Intersections tool to help understand points that exist in multiple surfaces 
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• Use the  button in the lower left edge of the Measure Status dialog.  

• Point selection options: There are two ways to display a point in the Point Surface 
Intersections dialog: Double click on a point in the Measure Status dialog or key in the 
obstacle’s object Id (Identifier) to the Obstacle Point ObjectId field.  

• The surfaces and their intersection heights populate automatically. View the results. 

• Drive options: Press the  button to drive Summit to the measured point. Double click on 
a surface in the list to drive Summit to the same point using the elevation of the surface. 

f. Previously, using Airfield3D to apply field values to a non-Obstacle object could sometimes corrupt the 
layer of the object. There is now more error checking to prevent this. Note that Airfield3D is designed to 
update the fields for objects on the Obstacle layer. For objects on all other layers, use the Field Update 
tool instead. (March 4, 2022) 

DAT/EM Capture for ArcGIS – ArcGIS Pro (Beta) 
DAT/EM Capture for ArcGIS Pro is compatible with versions: 

• ArcGIS Pro versions 2.3 through 2.9.3.. 

• The API no longer needs to be present on the hardware lock for Capture for ArcGIS Pro. If you have Capture for 
ArcGIS ArcMap and want to try Capture for ArcGIS Pro, use the DAT/EM CAD Enabler (standalone or located in the 
DAT/EM Administration Tool) to activate the extension for ArcGIS Pro. 

• Note: If you have ArcGIS Pro v.3.0, ask support@datem.com for the first v.8.2 beta that is compatible with it. 
Extensions built for ArcGIS Pro 2.x (as is the DAT/EM v.8.1 extension) will not work with ArcGIS Pro 3.0. 

DAT/EM Capture for ArcGIS Pro has the following changes: 

1. There is a new “Capture for ArcGIS Pro User’s Guide” document that matches DAT/EM Version 8.0 and 8.1. It 
was released after the 8.0 release. It is posted on the DAT/EM website. (December 8, 2021) 

2. The compatible version list has been expanded to include ArcGIS Pro versions 2.3 through 2.9.3. (January 19, 2022, 
July 2022) 

DAT/EM Capture and MapEditor for AutoCAD 
DAT/EM Capture and MapEditor for AutoCAD are compatible with the following AutoCAD versions: 

• 32-bit AutoCAD 2004-2008 versions with the latest service packs, as long as you can get them to install on your 64-bit 
operating system (OS). DAT/EM no longer tests on 32-bit OS, so these must be running on 64-bit OS. DAT/EM is not 
responsible for helping to install a 32-bit version of AutoCAD on a 64-bit OS and cannot guarantee that this will succeed. 

• 64-bit AutoCAD 2009-2023 versions with the latest service packs. Exception: 64-bit AutoCAD 2008 is not supported. 

When referring to a year/version number in the lists above, it includes "plain" AutoCAD, Civil3D, and Map3D. It does not 
include AutoCAD LT, which is a 2D product, and therefore will never work with a 3D cursor. 

Reminders: Install all available AutoCAD service packs and updates before installing DAT/EM software. Before installing DAT/EM 
software, run each version of AutoCAD and make sure its license is active. Do this for each version whether or not you intend to 
use every version with DAT/EM Capture. 

DAT/EM software will install for multiple AutoCAD products of different year numbers on the same computer; however, it will only 
install for one of multiple same-year versions that Autodesk installs in different “\Program Files\Autodesk” folders. In more recent 
versions, they install to the same folder, so this is no longer a problem. For older versions, they are in separate folders. For 
example, DAT/EM Capture will not install for both AutoCAD 2017 and AutoCAD Civil3D 2017 at the same time, because they are 
both the same year and installed in different folders. In the case of multiple same-year versions installed in separate folders, only 
one of them will receive the DAT/EM files at installation. We don’t know which one until after Autodesk installation. To activate 
DAT/EM Capture and/or MapEditor in all of them, the AutoCAD \datem folder and the DAT/EM wintab driver file may be copied 
from the one that received the files to the other same-year versions. Contact DAT/EM Support for instructions. 

DAT/EM Capture and MapEditor for AutoCAD have the following changes: 

mailto:support@datem.com
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1. AutoCAD 2023 is added to the compatible version list. It uses the same binaries and menus as for AutoCAD 2021 
and 2022, so the installation into the AutoCAD 2023 folder is the only thing that has changed. (March 29, 2022)  

2. The DAT/EM installation process for AutoCAD 2022 (all types of this year version) placed the “Wintab” digitizer 
file in the correct folder as Wintab64_2021.dll, but failed to rename it to Wintab32.dll so it could be used. This is 
fixed in the installation for v.8.1.  (September 4, 2021) 

Note: Workstations that installed v.8.0 or early v.8.1 betas for AutoCAD 2022 and attempted to configure the 
Wintab digitizer will need to force AutoCAD to reset the digitizer for the correct file. Once AutoCAD 2022 is set to 
the Wintab digitizer, but can’t find the correctly named Wintab32.dll file, it does not automatically recover proper 
operation when the file can be located. To force it to reload the new v.8.1 Wintab32.dll file, do this: 

• Install v.8.1 or higher dated 5 September 2021 or later. 

• Open AutoCAD 2022 (any type of that year version). 

• Start OPTIONS > System tab. 

• Set Current Pointing Device to “Current System Pointing Device”. 

• Close and reopen AutoCAD 2022. Do not skip this step. It must open without the Wintab set. 

• Return to OPTIONS > System tab. Set Current Pointing Device to “Wintab Compatible 
Digitizer…” and “Digitizer and mouse”. This will force AutoCAD to search for and load 
Wintab32.dll. 

• Verify that OPTIONS > Files tab > Support File Search Path still contains the two required 
DAT/EM folders, usually “C:\Program Files\Autodesk\AutoCAD 2022\datem” and “C:\Program 
Files\Autodesk\AutoCAD 2022\datem\bmp”. (These do not need to be changed for this 
process, but it’s a good idea to make sure you set them previously and they are still there.) 

3. SI Settings has two new rubber band settings:  (August 10, 2022) 

 
New Rubber band and Snap Rubber band settings 

 

 

 

 

 

Rubber band – When on, this is the 
superimposed rubber band that goes from the 
most recently digitized point to the Summit cursor 
location during drawing. 

Snap Rubber band – When on, this is the 
superimposed rubber band that goes from Summit 
cursor location to any potential snap locations 
during drawing. It will appear when AutoCAD’s 
Osnap is on and you are drawing an object within 
snapping range of another object. 

 

4. DATDRAW for AutoCAD is disabled. This command was added several years ago to try to mimic a similar tool in 
Capture for MicroStation; however, it never worked very well in the AutoCAD environment. We decided to 
discontinue it. If you used this command and miss it, please contact DAT/EM Support. (March 29, 2022) 
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5. MapEditor Cleanup has a new Zig Zag Filter option. A customer sent a file that had tiny 0.001-unit long 
segments that switched back and forth at or almost at 180 degrees along what should have been one straight 
segment. The Zig Zag Filter can detect such tiny segments by their angle to the adjoining segments (projected in 
the xy plane) and segment length and remove the second point.  (March 28, 2022) 

    

Before (left) and after (right) MapEditor Cleanup’s new Zig Zag filter 

Settings and recommendations for the Zig Zag filter: 

• In some files, it may help to run MapEditor Filter’s duplicate vertex removal first. If the tiny zig zag has a 
duplicate vertex at either end of the zig zag, it could prevent Cleanup from finding the zig zag, or it might 
leave a zig zag to the remaining duplicate vertex. 

• The Maximum angle setting is in degrees. So, for example, a setting of 0.75 is less than a degree. 

• Maximum length is set so that no segment is removed that is longer than this setting (in ground units). 

• Maximum length is checked before Maximum angle, since the check is faster. 

• Running the Zig Zag filter twice might find additional zig zags. 

 
Zig Zag filter settings should be made after investigating the length and angle of the zig zag problems in your file 
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6. EDITLINE has new 3DVertexShift (“3”) and 2DVertexShift (“2”) options. 3DVertexShift asks you to pick an 
existing vertex in the polyline and move it in (x,y,z). 2DVertexShift moves it in (x,y) only. 2DVertexShift was 
really only added for completeness, because normal dragging and dropping in AutoCAD will move the vertex in 
2D already. The new EDITLINE options work well with the Summit stereoplotter cursor, which provides good 3D 
input.  (April 22, 2022) 

Note that 3DVertexShift will change the elevation of an entire 2D polyline if used on it; it does not change the 2D 
polyline into a 3D polyline. Please let DAT/EM Support know if you want this to work differently on a 2D polyline. 

To use: 

• If Summit is not running and you plan to use the system mouse in the AutoCAD view to do a 3D vertex 
move, you must first use the AutoCAD ELEV command and key in the desired vertex elevation. If Summit 
is running and you will use Summit to pick, this is not necessary. 

• Start EDITLINE. 

• At any time that the main EDITLINE prompt is active, key in 3 to move the vertex in (x,y,z) if it is a 3D 
polyline, 3 to move the (x,y) of the vertex and the (z) of the entire polyline if it is a 2D polyline, or 2 to 
move the vertex in (x,y) for any polyline. 

• Follow the prompts to pick the original polyline vertex and the destination location. 

• The prompt will repeat so that you can move more vertices. 

• When finished moving vertices, submit <Escape> on the keyboard or a Cancel button in Summit’s Button 
Manager buttons. This will return the command to the main EDITLINE prompt. A second <Escape> or 
Cancel will end the EDITLINE command. 

7. PSQR and PSQR2D can now toggle their close setting with a new Auto close toggle option on their command 
line. Previously, this setting was only available in the SETUP dialog, and it had no key-in equivalent. Since it is 
now on the command line, it can be controlled from the keyboard (A key) or from A{RET} on the Keypad or a 
Button Manager button while PSQR/PSQR2D is running. The new prompts are as follows:  (March 29, 2022) 

Command: PSQR3D Square From point/Auto close toggle[ON]/Xy tol/Z tol/Plotter z[ON]: 
Command: PSQR2D Square From point/Xy tol/Auto close toggle [ON]: 

The following dialog shows the older location of the PSQR/PSQR2D close setting, which is still available and may 
be used as a default: 

 

 

 

 

SETUP’s default setting for 
PSQR/PSQR2D Automatically Close, 
which is now also accessible from the 
PSQR/PSQR2D Command lines 
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DAT/EM Capture and MapEditor for MicroStation CONNECT (64-bit versions) 
This section applies to Capture and MapEditor for 64-bit MicroStation CONNECT Editions (CONNECT). DAT/EM software 
installs for the following CONNECT versions:  

• MicroStation CONNECT Edition Updates 14-17. Note: Although it will install for earlier updates, Bentley’s 3D offsetting 
function wasn’t fixed until Update 14, so we recommend 14 and higher. “Update” numbers vary for the other products listed 
below. It is best if they are from a version concurrent with the DAT/EM release date. 

• OpenRoads Designer (ORD) CONNECT Edition 

• OpenCities Map CONNECT Edition 

• OpenCities Map Enterprise CONNECT Edition 

Certain earlier CONNECT versions may work with DAT/EM software, but are no longer supported. For higher versions and 
update numbers released after the DAT/EM release or software build date, contact DAT/EM Support for information. 

Starting March 24, 2020, DAT/EM software will install for CONNECT version values greater than 100000000 and less 
than 109900000 with a ProgramPath anywhere under the Software\Bentley\Installed_Products key in the registry. If 
your CONNECT version has a number older than this, we suggest updating it. Despite installing old versions, we do not 
guarantee Capture and MapEditor will work with them if CONNECT itself has bugs in functions that the DAT/EM 
applications access. In that case, please update the CONNECT version and then reinstall DAT/EM software. 

DAT/EM Capture and MapEditor for 64-bit MicroStation versions have the following changes: 

1. Tentative point snap detection, marking tentative points in superimposition, and moving to tentative points are 
now working fully in 64-bit MicroStation (“CONNECT”). Changes are as follows: (Multiple dates in 2022) 

a. Tentative snaps are now successfully detected in the MicroStation view. This enables them to be marked 
in superimposition and set behaviors to be activated upon a tentative point selection in MicroStation.  

b. Acceptable tentative point snap selections may originate in either the Summit view using a Summit cursor 
Button Manager button set to Generic CAD=Tentative or in the MicroStation view by clicking the right 
and left system mouse buttons at the same time. 

c. The Move stereoplotter to tentative setting (keyin: TENTATIVE MOVE <ON/OFF>) (shown in the 
DATEM SETTINGS graphic below) is now active. Previously, the setting could be checked on in the 
dialog, but Summit did not move. 

d. Tentative points that are not snapped to an existing element will now be marked in superimposition. 
(January 11, 2022) 

e. Previously, there were two sets of tentative point mark and label color options for superimposition. They 
were left over from an old workaround for 32-bit MicroStation XM, which was not necessary in 
CONNECT. The second label/mark and its mark settings were removed from DATEM SETTINGS; 
however, the tentative point behavior settings remain in DATEM SETTINGS:  

 
These previous tentative label/mark 
options have been removed from 
DATEM SETTINGS 

 
Tentative point behavior settings remain in DATEM SETTINGS 
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Tentative label/mark settings for superimposition are now located only in SI SETTINGS: 

 
Tentative point label/mark settings are located in SI SETTINGS 

 

2. Fixes for reference file use are as follows: 

a. Previously MicroStation CONNECT would fail to refresh its reference file graphics after any view pan or 
zoom synchronization initiated by Summit. The reference file graphics would disappear from the 
MicroStation view, and subsequently from any refreshed superimposition (SI) view. DAT/EM Capture now 
forces a MicroStation view refresh after any automatic panning and zooming. (November 4, 2021) 

b. Previously, there were Summit SI display problems when the main file and reference file had different 
global origins. Such reference files now display in the correct location in superimposition.  (March 4, 2022) 

c. Previously, there were problems when a DAT/EM command was told to scan for objects in (missing) 
reference files, such as checking on MECLIP’s “Include reference elements” setting when there is a 
missing reference file. DAT/EM software now skips references to files that are not available. (August 30, 
2022) 

3. DAT/EM implemented workarounds to avoid a MicroStation CONNECT crash when clipping an element that has 
not yet been written to the design. All DAT/EM commands that use clipping (including, but not limited to INTERP, 
MEVOLUME, JOINIT, ZLABEL, MECLIP, MEPATTERN, and CHANGEATTRIBUTES INTERIOR) now use a 
utility safe clip that checks whether an element descriptor has been written to the design, write it if not, and delete 
the element after the clip. Because this was unacceptably slow for mass editing, a more optimized clip was used 
for some commands, such as SHEETCUTTER. (November 5, 2021)  

4. MapEditor-only installations in v.8.0 were loading the MapEditorConn.ma file correctly, but this did not in turn load 
the required CommonConn.ma (“Common”) file. Common will now load automatically. In addition, there are 
added diagnostics. A failure to load Common correctly will show a window giving a diagnostic code to discuss 
with DAT/EM Support. (January 19, 2022) 

5. Rubber banding in Summit’s superimposition (SI) had several issues, which are now fixed. PLACE SMARTLINE 
now has an SI rubber band, for example, but the rubber band is improved for many other commands as well. Hint: 
If you find that MicroStation’s PLACE LSTRING STREAM is too slow with its proper rubber banding, use 
DATDRAW STREAM or BKTRACK instead. (February 7, 2022 and July 7, 2022) 
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6. Superimposition (SI) of the in-progress linework and the SI rubber band could be lost or drawn incorrectly if the 
Summit model changed automatically while drawing with commands such as AUTOARC or DATDRAW 
AUTOARC. A new automatic refresh solves this problem. (August 9, 2022) 

7. DAT/EM tools that write to the open CONNECT DGN file, such as Summit > File > Export > Export Model Bounds 
and DAT/EM Contour Creator, would disable proper operation of superimposition (SI) refresh in the MicroStation 
SI client. This is fixed. (February 14-15, 2022) 

8. Large batch edits that were interrupted, such as XYZIN giving a “File not Found” message, could turn off 
superimposition (SI) refresh for performance purposes, but would not fully reactivate it after the interruption. Now 
SI is fully reactivated at the proper times. (February 14, 2022) 

9. A collection of commands that create text and include font settings were updated to try to find missing fonts. They 
check for the existence of a named font in the MicroStation path (MS_FONTPATH) and add the found definition, if 
needed. Previously, the default font (STANDARD) would often be used instead of the set font name. On closer 
inspection, we found that font definitions could not be easily resolved. TRUE TYPE and SHX fonts were often 
unresolved, while MicroStation fonts seemed to resolve correctly most of the time. Commands affected include 
ZLABLE(s), GRIDIT, LD CP, MEVOLUME, and maybe more. (March 28, 2022) 

While working on this, we discovered that MS_FONTPATH set on the development machine did not include all of 
the commonly used fonts. This is highly likely to happen on individual installations as well. Based on the following 
Bentley article, we added the following paths to the MS_FONTPATH variable to get access to the common font 
definitions: https://communities.bentley.com/products/microstation/w/microstation__wiki/14552/missing-font     

 

 
Adding these paths worked for us, but you will have to decide whether your organization wants to do this. 

DAT/EM has no plans to modify MS_FONTPATH automatically. It is usually done at an administrative level based 
on organizational standards. We’re mentioning it, in case you have trouble with missing fonts and want to check 
this variable’s setting for your organization. 

10. Miscellaneous MapEditor fixes for operating on a parameter (PAR) file: (April 25, 2022) 

a. Fixed a problem where the comment toggle was not being applied to the current run. 

b. Fixed log file formatting errors (Unicode aesthetic issues). 

c. Fixed random memory corruption during linkage handling. Heap space was randomly corrupted while 
trying to preserve pre-existing linkages. Isolated the problem to 
mdlElement_appendAttributes(destination, length, attributeData). DAT/EM is preserving the linkages, but 
had to rework the code to get around the memory corruption that was occurring in the Bentley 
MicroStation 64-bit API. Fixed in 8.1 with the caveat that it would be best to ask customers to verify the 
linkages are correctly preserved. Email support@datem.com if you have comments.  

https://communities.bentley.com/products/microstation/w/microstation__wiki/14552/missing-font
mailto:support@datem.com
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11. Summit’s SI Layer Manager could be missing the names of empty (that is, no objects drawn in them) .dgnlib-
referenced levels that were displayed in the MicroStation Level Manager. CONNECT fails to report an event when 
such empty levels are added to the MicroStation environment. The levels are reported if they contain elements or 
you draw an element into the level. DAT/EM added a workaround to force a complete refresh of all level names 
from levels that also show up in the Level Manager. (August 10, 2022)  

12. There could be mysterious superimposition lines connecting points as they were edited in MicroStation. The lines 
did not appear in the MicroStation view. For example, if you moved three points, the points would then be 
connected by segments in the superimposition view. This is fixed. (August 2-4, 2022) 

13. Pattern elements will be shown in superimposition only if Patterns is on in MicroStation’s View Attributes. This 
applies to both 32- and 64-bit MicroStation versions. (July 6, 2022) 

 
14. Template reference linkages based on template locks have been added to: (July 29, 2022) 

o AUTOARC2D (and all subcommands except DRAWBREAK ON) 
o AUTOARC (and all subcommands except DRAWBREAK ON) 

Note: AUTOARC and AUTOARC2D SNAPPED <subcommands> will follow template configuration 
settings for newly digitized elements but will not alter settings on broken (snapped-to) elements. 

o BKTRACK (and all subcommands) 
o CHANGEATTRIBUTES. See details for this command in item 23 on page 35 below. 
o CPLINE 
o DATDRAW (and all subcommands) 
o LINESLOPE (and all subcommands) (optional text, line and cell linkages) 
o MEASUREHEIGHT (and all subcommands) (optional text and cell linkages) 
o MECPLINE 
o PSQR (and all subcommands) 

Background Information on template linkages and future plans: MicroStation’s ACTIVE ELEMENT 
TEMPLATE and ELEMENT TEMPLATE ASSOCIATION LOCK commands determine whether templates are 
applied to newly created elements. No additional settings have been added to the DATEM command set 
implementing the template-setting functionality, since MicroStation already does this. 
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The Element Template setting can be set interactively as shown in the graphic above or with the keyins: 
TEMPLATE ACTIVE <template> and LOCK TEMPLATEASSOCIATION ON. The former defines the active 
template and the latter specifies that affected elements will be linked to the template. The advantage is that 
template changes can be easily applied to linked elements. 

Bentley removed the legacy template API, and the new CONNECT API doesn't handle broken chains; therefore, 
strings that are broken (for example at intersections such as with AUTOARC_DRAWBREAK_ON) will not have 
template links, despite the template lock setting. This can be addressed with command recoding, but not at this 
time (not for version 8.1).  

DAT/EM may expand the use of template settings future versions. We need user feedback to know in which 
commands you need this functionality. Please contact DAT/EM Support at support@datem.com if you have 
requests regarding template linkages. 

 

15. Error diagnostics throughout the software have been corrected for Unicode compliance. For example, before 
corrections, one error messages might have shown, “Cannot read set [@&#)@%$& from registry.” 

16. DAT/EM shape-creation and related commands now avoid making consecutive double vertices in a shape. A 
shape with double vertices cannot always be used to create a fence in 64-bit MicroStation. DAT/EM’s fix ensures 
that DAT/EM commands create shapes that can be used for fence creation. Affected commands are: (August 18, 
2022) 

CHANGEATTRIBUTES 
CROSSCHECK 
FACESHIFT 
INTERP 
 

JOINIT 
LCLOSE 
MECHANGEATTRIBUTESINTERIOR 
MECLIP 
 

MEPATTERN 
MEVOLUME 
SHEETCUTTER 
XYZOUT 

mailto:support@datem.com
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17. MicroStation Level Manager’s “Level Overrides” symbology was working for color only in superimposition when 
activated with the SI SETTINGS > Show overrides symbology in SI setting. Now it is working for color, weight, 
and line code overrides in both 32- and 64-bit MicroStation. (September 16, 2022) 

 
Level overrides shown in Level Manager (left), superimposition (center), and SI SETTINGS (right) 

 
ByLevel settings shown in Level Manager (left), superimposition (center), and SI SETTINGS (right) 

18. 3DOFFSET and ROAD would not offset a single-segment line. This is fixed. (January 5, 2022) 

19. AUTOARC2D and AUTOARC <all subcommands except DRAWBREAK ON> will now apply template references 
based on the current template locks. See item 14 above. (July 29, 2022) 

20. BKTRACK STREAM has code simplification, added error handling, and corrections to its complex dynamics code. 
Previously, it could crash on digitizing the first point of the second element, after successfully finishing the first 
element.  (June 16 and October 27, 2022) 

21. BREAKLINEFILTER, BUILDINGFRAME, and XYZOUT have a fix for reporting missing selection set names. 
Previously, when the software encountered a selection set name that didn’t exist on the current workstation, the 
message contained unreadable characters. (September 3, 2021) 
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22. Clip (MECLIP) has the following changes: 

a. MECLIP followed by Change Attributes Interior (MECHANGEINTERIOR) in a MapEditor parameter file 
would cause a “ghost fence” that would not go away and superimposition (SI) refresh would no longer 
work. Change Attributes Interior had two problems: 1) A timing problem could result in SI being turned off 
and not being turned back on, and 2) The temporary fence created for calculation was not being cleared. 
This is fixed.  (November 23, 2021) 

b. There was a dialog error in setting the boundary set. This is fixed in 32- and 64-bit versions. (August 30, 
2022) 

c. There was a race condition from how MECLIP interfaced to the MapEditor picker library. This is fixed.  
(August 30, 2022) 

d. MECLIP with Include reference elements as boundaries checked on could “access” a CONNECT bug 
in handling missing reference files. Now it avoids the problem. (Bentley is ultimately responsible for fixing 
the bug in CONNECT.)  (August 30, 2022) 

23. CHANGEATTRIBUTES now supports active template links for the semi-interactive and the MapEditor batch 
version of the command.  

o Individual attributes: This is the default setting with configurable level, color, style, and weight settings, 
which were previously available. 

o Active Symbology changes selected elements to the current active symbology settings. It does not link a 
template to the selected elements, regardless of the current locks. 

o Active Element Template links the current active element template to selected elements and sets 
elements to active symbology. This is done regardless of lock settings (tentative) but an error will be 
raised if an active template has not been specified. 

  
New active symbology and active element template options in Change Attributes 
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Hint: To set the active template and/or level and attributes symbology inside a MapEditor parameter file before 
running the Change Attributes command, use the Parameter File Editor’s Generic Keyin command to set the 
template in the active settings. For example, these key-ins could make the settings: 

Lv=<level>    note: “Level Names with spaces need quotation marks around the level” 

co=<color name or number> 

Lc=<line code style name or number> 

wt=<weight number> 

template active <template name\with any category separators\like this> 

Follow the active attributes and/or template setting with the Change Attributes command that uses the now-active 
settings. 

24. CPLINE will now apply template references based on the current template locks. See item 14 above. (July 29, 2022) 

25. CROSSCHECK has the following changes: 

a. CROSSCHECK’s marker options would revert to “temporary marker” after setting another option. The 
setting is now retained for the next appearance of the dialog. (September 21, 2021) 

b. CROSSCHECK has added options for what to do at found intersections. All options: (September 22, 2021) 

• Preserve elevations – Keeps any 2D intersections intact at the objects’ original elevations. 

• Match/average elevations – Sets the intersection (nodes or broken endpoints) to the average of 
the original elevations of the two elements at the intersection. 

• (New!) Set to Z of first element – Sets the node or endpoints of the element from the second 
selection set (lower selection set in the dialog) to the elevation of the element from the first 
selection set (upper selection set in the dialog) at the intersection. Does not change the elevation 
of the element from the first selection set. 

• (New!) Set to Z of second element – Sets the node or endpoints of the element from the first 
selection set (upper selection set in the dialog) to the elevation of the element from the second 
selection set (lower selection set in the dialog) at the intersection. Does not change the elevation 
of the element from the second selection set. 

 
New CrossCheck options for intersection elevation editing 
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c. CROSSCHECK in the MapEditor Parameter File Editor (batch) commands was missing some settings 
that the semi-interactive CROSSCHECK version of the dialog offered. The batch options now match the 
key-in dialog options. Additions include:  (September 28, 2021) 

• No Change options are added to both set groups. 

• Break and Add vertex radio buttons in both groups have been turned into an option block 
containing the following options: Break, Add vertex without breaking, and No Change. 

• An option to not edit intersections based on how large their Z difference is, an option to skip 
snapped intersections, and the new Set Z of first element and Set Z of second element 
options shown above. The numbers are mapped the same as before for the first two 
options, providing backward compatibility. Users will not need to modify their PAR files 
unless they wish to make use of the new "No Change" option. 

 
Highlights show areas of change in the CrossCheck batch dialog 

Important! You may need to edit old PAR files! Since there are more options in batch now, you may need 
to edit any CROSSCHECK instances in existing PAR parameter files. The numbers for pre-existing 
settings are mapped the same as before, providing backward compatibility; however, the new options will 
be missing from old files and will be run as default settings if they are not found in the PAR file. 

d. The Parameter File Editor display for CROSSCHECK was improved for readability. (September 28, 2021) 

e. CROSSCHECK’s error handling was improved. (September 28, 2021) 

f. CROSSCHECK has a fix for a dialog setting edit in parameter (PAR) files. 

26. CRBUILDING (“Copy and Rotate Building”) and CRSELECTION <TRANSON\TRANSOFF\TRANSTOGGLE> 
have been added to 64-bit versions of MicroStation. CRBUILDING copies a shape or line string, then places the 
copy at a new location and rotation angle. The rotated copy retains the Z values of the original element. 
CRSELECTION copies currently selected elements to a new location and rotation angle allowing the user to 
disable/enable the display in Summit while the elements are moved. (July 2022) 

27. DATDRAW commands have the following changes: 

a. DATDRAW PSQR superimposition rubber banding was improved. 

b. DATDRAW will now apply template references based on the current template locks. See item 14 above. 
(July 29, 2022) 

c. DATDRAW AUTOARC has increased error checks. (August 4, 2022) 
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28. DATEM SETTINGS’ Automatically rotate view to model setting was previously ignored. Now when checked on, 
it will prevent the MicroStation view from rotating to match the Summit model’s kappa angle. (December 13, 2021) 

 
 

29. When editing an existing DELETE OBJECT line in the MapEditor Parameter File Editor, it would not show the 
correct selection set given in the parameter file. This is fixed in both 32- and 64-bit MicroStation versions. (August 
27, 2021) 

30. CULVERT, CULVERT MIDLINEOFF, and CULVERT MIDLINEON have been added. The user sets an active cell, 
then places the endpoints of a midline (representing the ends of a culvert pipe), and it places the active cell at 
either end of the line. When CULVERT MIDLINEON is active, it also places the midline as an element.  (February 
14, 2022) 

 
The CULVERT drawing command is now active for 64-bit MicroStation 

31. DTM FENCE has the following fixes in both 32- and 64-bit MicroStation: (August 8, 2021) 

a. When moving, it would report, “Moving to x, z.” This was fixed to show the y coordinate rather than z. 

b. A legacy 32-bit memory allocation problem for storing elements within a fence was fixed so that it reflects 
the data type that needs to be stored. The same change was made for 32-bit versions for consistency. 

32. DTM SAMPLE showed a dialog that was too small to move on screen. Now the dialog is wide enough to allow an 
area where the system mouse can grab it and move it.  (August 24, 2021) 

33. FILTER (MEFILTER) has the following changes: (August 23, 2022) 

a. In cases where the input settings were not realistic, it could have filtered a shape down to only two points, 
making a zero-area shape. Now it can’t make a zero-area shape. 

b. It now retains dialog settings after visiting the Selection Sets Editor from the button in the dialog.   

34. ELINE commands in both 32- and 64-bit MicroStation were allowing initial selection of element types that were 
not supported in code. The element types that are now permitted are: Type 3 lines, type 4 line strings, type 12 
complex chains, type 6 shapes, type 14 complex shapes, and type 16 arcs. Any other element types can no 
longer be selected for ELINE editing. (August 27, 2021) 

35. Export Model Bounds (Summit > File > Export > Export Model Bounds) now correctly places the model name’s 
text along with the model’s boundary shape. In addition, it no longer disables superimposition refresh. (February 14, 
2022) 
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36. FACESHIFT commands have the following changes: 

a. FACESHIFT OFFSETS has been added to the 64-bit platform. (June 6, 2022) 

b. FACESHIFT GRID’s rubber band lines were correct in MicroStation’s view, but not in superimposition. 
This is fixed. (January 6, 2022)  

The following items affect all FACESHIFT commands:  

c. Added a range filter to the scan, so the scan no longer reads all points in the file. (April 6, 2022) 

d. Corrected a descriptor deallocation problem where a read failure might corrupt element descriptor 
storage. (April 6, 2022) 

e. Corrected a messaging problem where diagnostic counts were thrown on each processed point, which 
would overflow the MicroStation Message Center.  Statistics are now displayed once after points within a 
polygon are processed. (April 6, 2022) 

f. Added diagnostic messaging to report algorithmic failures. These will appear in the MicroStation Message 
Center. (April 6, 2022) 

g. Removed unnecessary allocation/deallocation, which was not checking for failure.  Added some missing 
error checks. (April 6, 2022) 

h. FACESHIFT often uses a function in MicroStation that determines whether a point is inside or outside a 
polygon and edits it based on a boresight method in the active view. Bentley’s boresight method has the 
potential of moving the (x,y) of the point as well as the (z) when the view is rotated in 3D. Now DAT/EM 
makes sure the (x,y) of each point remains at the original values when the (z) is changed. (May 31, 2022) 

i. FACESHIFT POLYGON was missing occasional points due to failures in the BoresiteToSurface function. 
There is a new DAT/EM failover algorithm to use in FACESHIFT when Bentley MicroStation’s 
BoresiteToSurface function experiences occasional failures in 64-bit versions. This function is meant to 
determine whether a point is inside a polygon. It is possible for us to detect when it has failed and send 
the point on to the failover algorithm. Since the failover algorithm is slower, we do not plan to use it for 
100% of the points. (May 31, 2022) 

j. FACESHIFT POLYGON had some rubber banding issues that are now fixed. (June 20, 2022) 

k. FACESHIFT POLYGON would not be in the queue as the most recently run command. If you finished 
FACESHIFT POLYGON and then began to digitize again, it would reactivate the second-to-last-run 
command. This is fixed. (June 20, 2022) 

37. GRIDIT, REPLACE CELL, XYZIN and the command that attaches a cell library in the Parameter File Editor 
previously used a now-deprecated method for finding the currently attached cell library. Users might have seen an 
erroneous warning, “Cell Library not Attached.” This has been fixed. (October 4, 2021) 

38. INTERP is now available for 64-bit versions. This command adds elevation contours (usually intermediate 
contours) between existing elevation contours (usually index contours). (October 5, 2021) 

39. JOINIT has the following changes: 

a. JOINIT would join type 3 lines into a complex element consisting of one line string. This has been fixed to 
simplify the element into a type 4 line string. (September 1, 2021) 

b. JOINIT had some API calls that were passing a null value for the Master File ID. This used to work in 
earlier versions of MicroStation, but it started crashing in V8i SelectSeries 2 and higher. This is fixed for 
both 32- and 64-bit versions. (October 4, 2021) 

c. JOINIT has added error handling and fixed a boundary condition issue. The problem was isolated to a 
closing join operation performed between a regular line string and a very tiny line (.5 UOR, almost a 
point). Sometimes the join succeeded and the resulting shape looked fine. Other times, the operation 
would fail at various stages of the join. In all cases, 64-bit MicroStation storage had been 
corrupted. (Note: 32-bit MicroStation versions are able to handle this boundary condition.) The code is 
changed to skip these tiny line strings. (May 4, 2022) 
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40. LD CP DLG/SETTINGS has fixes for the following: (March 16, 2022) 

a. It was placing point cells on the active level and not using the level that was set in Advanced Settings 
(when “Use active attributes” was off). 

b. It was placing text and cells at different sizes than the settings indicated. 

c. Place text XYZ settings were not always saved. 

41. All LINESLOPE commands (optional text, line and cell linkages) will now apply template references based on the 
current template locks. See item 14 above. (July 29, 2022) 

42. All MEASUREHEIGHT commands (optional text and cell linkages) will now apply template references based on 
the current template locks. See item 14 above. (July 29, 2022) 

43. MECLOSE “Close Line string” launched from a parameter file has the following changes: 

a. The PAR file version of MECLOSE was missing recently added settings, “Skip elements when end 
segments cross,” and “Close as Shape/Snap ends.” Edits might be missed due to crossing segments. 
Settings now match the interactive version of MECLOSE. 

b. MECLOSE now operates on type 11 curves. 

44. MECPLINE (semi-interactive batch version of CPLINE) has the following changes: 

a. MECPLINE and XYZIN would crash using the Sets button to launch and subsequently cancel or close the 
Selection Sets Editor.  This is fixed. (October 12, 2021) 

b. MECPLINE will now apply template references based on the current template locks. See item 14 above. 
(July 29, 2022) 

45. MEXPORT contains additional output choices. Output formats now include XYZOUT, VISIT, SRV, and CEAL. 
Both SRV and CEAL can use either existing (legacy) binary EXP configuration files or the new ASCII text EXPV2 
format. EXPV2 can be edited with any text editor and viewed using the Export Options dialog. Legacy EXP files 
can still be edited with the MEXPORT Export Options dialog, but users are advised to move away from this format 
in favor of EXPV2. (September 16, 2021) 

Note: EXP, EXP2, SRV, and CEAL formats are mainly used by the Wisconsin Department of Transportation 
(“WisDOT”) and their photogrammetry contractors. WisDOT helped develop the new EXPV2 format to replace the 
legacy 32-bit-only binary EXP file library that was used in MEXPORT for 32-bit MicroStation. 

The Edit button may be used to view the contents of EXPV2 and both view and edit EXP. EXPV2 can’t be edited 
from the Export Options display. Use a text editor such as Windows Notepad or WordPad to edit EXPV2. 
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The EXPV2 format is described as follows: 

• Unlike the previous EXP format, in EXPV2, the item type (line, shape, or point) is used by both 
the SRV and CEAL formats. 

• Line format (this is one record that has wrapped in this document; there is no line feed.) The entry 
separator is a colon : character..  “(…)” is used to explain the entry and is not entered in the line. 
“/” is used to indicate an alternative setting and is not a character in the line.): 

item:l (for line)/s (for shape)/p (for point):<permitted element 
type number(s) separated by commas (*)>:level name:color 
number:weight number:line style number:SRV label:CEAL label 

 

(*) – Permitted element type numbers may include one or more of the following 
(separated by commas):  

3 (LINE_ELM) 
4 (LINE_STRING_ELM) 
6 (SHAPE_ELM) 
11 (CURVE_ELM) 

12 (CMPLX_STRING_ELM) 
14 (CMPLX_SHAPE_ELM) 
17 (TEXT_ELM) 
2 (CELL_HEADER_ELM) 

For example, a permitted element type entry of 3,4,11 would include lines, strings, and 
curves in the output. See example records in the graphic above. 
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• The text components of this line are case sensitive. Use a lower-case letter l for a line, lower-
case s for a shape, lower-case p for a point, and match the character cases for each character in 
the level name to what you would see for it in the MicroStation Level Manager. 

• Symbology filters: 

o Level name is used instead of level number. 

o Level name is case sensitive. 

o Level names must be defined in the current MicroStation file. Entries with undefined 
levels will not be displayed in the Edit-button-produced pane. 

o A list of MicroStation element numbers can be found here: 
https://communities.bentley.com/products/microstation/w/microstation__wiki/8855/elemen
t-numbers-and-types . For example, a shape is type 6, a line string is type 4, and a 
complex chain is type 12. Use the number only, not the element name. 

o For color, weight, and line style, the entry must contain either a MicroStation 
color/weight/style number, -1 (for ByLevel), or * (for the “All” wildcard). 

• # at the beginning of a line indicates a comment. The entire comment line will be ignored. 

 

46. MVPARTIAL has been added for 64-bit MicroStation. This is used to move a specified section of a line string to a 
new location. The section remains connected to the original line string.  (February 4, 2022) 

47. MVUSER has improvements as follows:  (January 13, 2022) 

a. Any changes to the MVUSER dialog parameters will terminate an ongoing Pick operation. Pick 
termination will occur immediately as the fields are edited. 

 
b. Pick mode operation is now cancelled when the dialog is closed (through Cancel or top corner X). 

48. NEARESTZ could make a complex shape that contained one simple shape. This has been corrected to drop 
these results to a simple shape.  (December 20, 2021) 

49. PLACE SMARTLINE (MicroStation command) would not produce a superimposition rubber band. This is fixed. 
Note that PLACE SMARTLINE must be started from the MicroStation Key-in Browser or a DAT/EM method such 
as the DAT/EM Keypad or Summit’s Custom CAD buttons to be detectable.  (January 5, 2022) 

50. PLOTTERSCALE <value> has been added for 64-bit MicroStation. PLOTTERSCALE sends a map scale setting 
to be applied in the Summit view. For example, PLOTTERSCALE 500 would adjust the Summit view so that 
Summit’s Map Scale display in the lower right corner shows 500.  (January 4, 2022) 

51. PLOTTERZOOM <value> wasn’t working if <value> was between 0 and 1 or 10 and above or for any non-whole 
number. This is fixed so that any number or decimal number over 0 may be used.  (January 4, 2022) 

52. PSQR will now apply template references based on the current template locks. See item 14 above. (July 29, 2022) 

https://communities.bentley.com/products/microstation/w/microstation__wiki/8855/element-numbers-and-types
https://communities.bentley.com/products/microstation/w/microstation__wiki/8855/element-numbers-and-types
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53. RUNPAR (to run MapEditor parameter files from a command line or dialog) has the following changes: 

a. Performance enhancements and error checks added. (March 2022, October 20, 2022) 

b. Parser corrections in 32- and 64-bit versions to allow spaces in directory and file names. (March 2022) 

c. The 64-bit version may run the parameter file (“parfile”) in some betas without launching a dialog. It will be 
changed to launch the dialog and auto fill the file name into the parameter file list. This will make it 
consistent with how the 32-bit version works, as well as give the user the opportunity to set a log file and 
multiple .dgn files, if desired. (March 2022) 

d. Isolated a performance issue to the MicroStation mdlWorkDgn API and coded around it for runpar 
functionality. (March 2022) 

e. The key-in format was not clear and in some cases was not working. The key-in and its options are now 
as follows: (March 2022) 

RUNPAR <<optional parfile to run immediately on current dgn> <, <optional logfile>> 

• RUNPAR – by itself will raise a dialog populated with the most recent <parfile><dgn> pairs. 

• RUNPAR <parfile> – will run <parfile> immediately on the current master dgn. Logging will be 
disabled. 

• RUNPAR <parfile>, <logfile> – will run <parfile> immediately on the current master dgn with 
logging enabled and sent to <logfile>. 

Example with log file: RUNPAR C:\My PAR files\123.par, C:\My Log files\123.log 

Example without log file: RUNPAR C:\My PAR files\123.par 

f. The Current design file only checkbox now runs the parameters file(s) on the current design file. 
Previously it would only open the log file, if set, but would then exit without doing anything. (October 20, 2022) 

g. If the last design file in the list matched the current master file, RUNPAR would hang after completing the 
parameter files run. Edits on other listed design files would complete successfully, while edits on the 
current file would be lost when the user exited out of the hung session. This is fixed. (October 20, 2022) 
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54. Scallop (MESCALLOP) has the following changes:  (September 29, 2022) 

a. The Distribute remainder option could leave one large arc between the original element’s endpoints. 
This is fixed to restore the proper arc placement and distribution of the remainder. 

b. The backup level option was creating the level, but the original element was not being written to the level. 
This is fixed. 

c. Dialog options set before selecting an element are now retained.  

55. The Selection Sets Editor has the following changes: 

a. The Rename option is now working properly to rename an existing set.  (January 18, 2022) 

b. The Selection Set Editor’s options to edit members of the selection set list (we’ll call them “cell lines”) had 
trouble with type 2 cells, type 35 shared cells, and the “All Cells” wildcard. Sometimes the cell lines’ 
attributes were set to “Default” and other times they were cleared, causing problems with any edits, such 
as deleting or editing cell lines from the list. This is fixed.  (September 27 and October 12, 2022) 

56. SELECTEDSETZ has been fixed to correctly handle unspecified elevation settings. The command is used in two 
forms: SELECTEDSETZ <value>, which worked well to set the selected object(s) to the value, and 
SELECTEDSETZ, which was meant to apply MicroStation’s active elevation to the selected object(s). Instead of 
the active elevation, another value would be applied; this is now fixed.  (December 21, 2021)  

57. SLOPECHECK has the following changes:  (January 17, 2022) 

a. The Sets button would activate the Selection Sets Editor, but the dialog would be frozen and could not 
return to the SLOPECHECK dialog when finished. This is fixed. 

b. The dialog backup options are now saved between runs. 

c. The dialog wording now indicates that VISIT can be launched. 

d. The Marker Options are now passed successfully to VISIT, if launched. 

58. SLOPEHATCH has the following improvements:  (January 18, 2022) 

a. The “Relative active fence” option now activates properly when there is an active fence. 

b. The prompt, “Short line length as % of max,” was changed to, “Short line length as factor of max.” There 
is no change to how the value was used, which was always as a factor rather than percentage. For 
example, entering 0.25 will make the short mark one quarter as long as the long mark. 

59. Superimposition and SI UPDATE for MicroStation CONNECT have the following fixes: 

a. SI UPDATE no longer clears existing fence graphics from superimposition for 32- and 64-bit MicroStation 
versions.  (August 19, 2021) 

b. SI UPDATE has fixes for properly displaying shared cells. 1) Shared cells placed as a type 
SHAREDCELL_DEF_ELM (Type 34) were previously skipped. 2) Error translating cell symbology has 
been corrected.  (September 20, 2021) 

c. Superimposition now displays the proper override symbology for text elements. 

d. When Level Overrides were set in SI SETTINGS, overrides for Line Style and Line Weight weren’t 
displayed correctly in Summit superimposition. This has been corrected. Note: When Level Overrides is 
set, level symbology will be displayed in SI even if it is not displayed in MicroStation.  (October 7, 2021) 

60. SPOTINTERP SETTINGS’ DTM Point dialog has fixes to retain settings made in the session.  (February 3, 2022) 

61. TENTATIVE MOVE <ON/OFF> and the same setting offered in the DATEM SETTINGS’ “Move stereoplotter to 
tentative” option is now working. Summit will now move to any tentative point location as the tentative point is 
selected. Tentative point selection can either originate in the Summit view or the MicroStation view. See more 
information in item 29. on page 29 above. (January 11, 2022) 
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62. TENTATIVEDISPLAY has been added to match the version of this command previously available in 32-bit 
versions. It shows information about the current tentative point. (July 7, 2022) 

63. TOUCH BATCH’s Sets button process now properly returns to the Touch Batch dialog after the resulting 
Selection Sets Editor closes. (January 28, 2022)  

64. VISIT’s Zoom to element extents has been fixed. (January 31, 2022) 

65. XYZIN and MECPLINE would crash using the Sets button to launch and subsequently cancel or close the 
Selection Sets Editor. XYZIN has a further fix to show the proper list of available selection sets in its menu. 
(October 12, 2021 and February 8, 2022) 

66. XYZMODIFY, XYMODIFY, and ZMODIFY have added support for cells, shared cells, text, and text nodes.  
(November 16, 2021) 

67. XYPARTIAL and XYZPARTIAL have been added for 64-bit MicroStation. XYPARTIAL replaces a section of a line 
string with either one straight segment or a newly digitized set of vertices. It interpolates the elevation of new 
vertices based on the connecting vertices on the original element. XYZPARTIAL Replaces a section of a line 
string with either one straight segment or a newly digitized set of vertices. The new vertices take the elevation of 
the stereoplotter if using the stereoplotter for selection, or MicroStation’s active elevation if using the system 
mouse for selection.  (February 4, 2022)  

68. ZCHECK now raises a notification when ZCHECK has completed, but no errors were detected.  (September 26, 2022) 

69. ZLABEL has the following changes: 

a. The VISIT options are now enabled in ZLABEL GUIDER and ZLABEL INTERVAL.  (April 11, 2022) 

b. ZLABEL now clears any previously selected objects from the “Selected element” section of the dialog 
between runs of the dialog.  (February 28, 2022) 

c. Text fields from .ZLAB configuration files in CONNECT were read with an appended <CR> (‘\n’). This was 
noticeable when attempting to match entries in lists (for example, Font list). The dialog would show the 
first entry in the list rather than the currently selected (Font). It would run correctly unless the user saved 
with the first entry still set. 

d. ZLABEL had some compatibility problems between .ZLAB configuration files made in previous 32-bit 
versions and imported into a 64-bit CONNECT version. To address these issues: a) the 32-bit version 
needed to be altered to skip unrecognized settings created from CONNECT. b) CONNECT needed to be 
modified to default missing parameters to match labeling behavior if run from the 32-bit version 
(previously, it defaulted to the most recently used parameters from the registry).  c) Text Style was 
missing from the 64-bit .ZLAB configuration file and has now been added.  (October 6, 2022) 
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e. For CONNECT only, the buttons for exporting and importing ZLABEL’s text and cell settings have been 
moved from the Text/Cell Settings dialogs to the main ZLABEL Commands dialog.  (October 6, 2022) 

 
ZLABEL’s configuration Import/Export buttons are now in the ZLABEL main dialog 

f. ZLABEL was placing view independent text, so the text angle would only look good in an unrotated top 
view. Now it places view dependent text, so it looks good for any view rotation.  (October 11, 2022) 

g. ZLABEL was placing text nodes where text-type elements were expected. This is fixed. Note that there 
are still cases where text nodes might be placed, but this will be less frequent. Please let DAT/EM know if 
any command places a text node where you expect a text element.  (October 11, 2022) 

h. ZLABEL with Clip object around text checked on would not label and clip the same input element more 
than once. For example, if there were two guiders crossing the same input line string, only the first guider 
intersection would be labeled and clipped; the remaining fragments after the first clip would not be 
labeled. This is fixed.  (October 13, 2022) 

 
 

DAT/EM Capture and MapEditor for MicroStation (32-bit versions) 
Changes apply to Capture for MicroStation for 32-bit MicroStation versions. DAT/EM software installs for the following 32-bit 
MicroStation versions:  

• MicroStation V8* and V8 2004 Edition*: Version should be 08.05.00.34 or higher. 

• MicroStation XM*: Version should be 08.09.04.88 or higher. 

• MicroStation V8i and V8i-based products in SelectSeries numbers 3*, 4*, and 10 (SS10 recommended). DAT/EM 
software may install for SelectSeries 1 and 2 in some of the products, but those SelectSeries versions are not 
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recommended. The V8i and V8i-based products are V8i, Bentley Map, Map Enterprise, PowerView, Map PowerView, 
Power GeoPak**, and PowerCivil. 

If you upgrade to a higher Select Series number, you must reinstall DAT/EM software after installing the Series upgrade.  

DAT/EM will install for all supported versions of MicroStation (also including 64-bit CONNECT products) that are present on 
the computer at the time of the DAT/EM installation. 
 
*Note about all 32-bit MicroStation versions: Be aware of this situation! DAT/EM v.8.1 is supported on Windows 10 and 11. 
The only 32-bit MicroStation version that Bentley supports on Windows 10 at the time of DAT/EM v.8.1 release is V8i 
SelectSeries 10, and there are no 32-bit MicroStation versions officially supported on Windows 11. Therefore, DAT/EM is in 
the difficult position of supporting more 32-bit MicroStation versions and Operating Systems than Bentley itself supports. 
DAT/EM software will continue to install for MicroStation V8, V8 2004 Edition, XM, V8 SelectSeries 3-10 as long as possible; 
however, if Bentley stops allowing DAT/EM to license any of these versions for our development environments, then we will 
not be able to compile for them any longer, and we will be forced to drop support for all 32-bit MicroStation versions that 
Bentley won’t license. Bentley encourages their users to upgrade to 64-bit MicroStation CONNECT. 
 
**Note about Power GeoPak Select Series 3: DAT/EM Software installs for Power GeoPak SS3, but has initial loading 
conflicts that affect the GeoPak and DAT/EM menus. Bentley offered a workaround for this issue, but DAT/EM doesn’t think 
it’s worth the time. Bentley doesn’t support Power GeoPak SS3 on Windows 10 or 11, anyway. 
Note about Power GeoPak Select Series 4 (which actually contains SelectSeries 3 in conflict with its name): This 
product seems to be more successful running together with DAT/EM applications. There still could be issues. If you are 
installing for this product, please contact DAT/EM Support. 

DAT/EM Capture and MapEditor for 32-bit MicroStation versions have the following changes: 

1. The legacy 32-bit API had problems handling reference files when the main file and reference file have different 
global origins. Note that the 64-bit (CONNECT) API also had such reference file problems, which have also been 
corrected. Reference files are now displayed at the correct location in superimposition.  (March 4, 2022) 

2. Pattern elements will now be shown in superimposition only if Patterns is on in MicroStation’s View Attributes. 
This applies to both 32- and 64-bit MicroStation versions.  (July 6, 2022) 

 
3. MicroStation Level Manager’s “Level Overrides” symbology was working for color only in superimposition when 

activated with the SI SETTINGS > Show overrides symbology in SI setting. Now it is working for color, weight, 
and line code overrides in both 32- and 64-bit MicroStation. (September 16, 2022) 
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Level overrides shown in Level Manager (left), superimposition (center), and SI SETTINGS (right) 

 
ByLevel settings shown in Level Manager (left), superimposition (center), and SI SETTINGS (right) 

4. CHANGEATTRIBUTES run from a MapEditor PAR file was missing some parameters. These have been added to 
both 64-bit and 32-bit product versions. 

5. Clip (MECLIP) had a dialog error in setting the boundary set. This is fixed in 32- and 64-bit versions. (Aug. 30, 2022) 

6. CROSSCHECK for both 32- and 64-bit MicroStation versions has added options for what to do at found 
intersections. All options: (October 1, 2021) 

o Preserve elevations – Keeps any 2D intersections intact at the objects’ original elevations. 

o Match/average elevations – Sets the intersection (nodes or broken endpoints) to the average of the 
original elevations of the two elements at the intersection. 

o (New!) Set to Z of first element – Sets the node or endpoints of the element from the second selection 
set (lower selection set in the dialog) to the elevation of the element from the first selection set (upper 
selection set in the dialog) at the intersection. Does not change the elevation of the element from the first 
selection set. 

o (New!) Set to Z of second element – Sets the node or endpoints of the element from the first selection 
set (upper selection set in the dialog) to the elevation of the element from the second selection set (lower 
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selection set in the dialog) at the intersection. Does not change the elevation of the element from the 
second selection set. 

 
New CrossCheck options for intersection elevation editing 

7. When editing an existing DELETE OBJECT line in the MapEditor Parameter File Editor, the correct selection set 
in the parameter file was not displayed. This is fixed in both 32- and 64-bit MicroStation versions. (August 27, 2021) 

8. DATPAN ON would no longer pan (zoom center) in some 32-bit MicroStation versions if the cursor left the area of 
the existing element extents in a file that had large negative coordinates and a small element extents area. This is 
fixed. (June 10, 2022) 

9. DTM FENCE has the following fixes in both 32- and 64-bit MicroStation: (August 24, 2021) 

a. When moving, it would report, “Moving to x, z.” This was fixed to show the y coordinate rather than z. 

b. A legacy 32-bit memory allocation problem for storing elements within a fence was fixed in 64-bit 
MicroStation so that it reflects the data type that needs to be stored. For consistency, the same change 
was made for 32-bit versions. 

10. ELINE commands in both 32- and 64-bit MicroStation were allowing initial selection of element types that were 
not supported in code. The element types that are now permitted are: Type 3 lines, type 4 line strings, type 12 
complex chains, type 6 shapes, type 14 complex shapes, and type 16 arcs. Any other element types can no 
longer be selected for ELINE editing. (August 27, 2021) 

11. JOINIT had some API calls that were passing a null value for the Master File ID. This used to work in earlier 
versions of MicroStation, but it started crashing in V8i SelectSeries 2 and higher. This is fixed for both 32- and 64-
bit versions. (October 4, 2021) 

12. RUNPAR (to run MapEditor parameter files from a command line) has corrections to the parser in 32- and 64-bit 
versions to allow spaces in directory and file names. (March 1, 2022) 

13. SI UPDATE is fixed so that it does not clear any existing fence graphics from superimposition for 32- and 64-bit 
MicroStation versions.  (August 19, 2021) 

14. TWOSHOT / THREESHOT: THREESHOT is now restored for 32-bit MicroStation only. THREESHOT, which is a 
3-point cell placement tool that can set the x and y scales differently, was added in v.7.6, but disabled in v.8.0 due 
to issues with certain types of cells. We had future plans to add the 3-pick functionality to TWOSHOT instead. By 
customer request, we restored THREESHOT for 32-bit only and plan to keep it as-is. Sometime in the future, we 
plan to add the 3-pick functionality to TWOSHOT in 64-bit MicroStation. 

As a side effect of restoring THREESHOT, the TWOSHOT ALIGN commands had to be disabled in 32-bit 
MicroStation. They are part of THREESHOT and could not be in both TWOSHOT and THREESHOT.  (May 4, 2022) 
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15. ZLABEL had some compatibility problems between .ZLAB configuration files made in 32-bit versions and 
imported into a 64-bit CONNECT version. To address these issues: a) the 32-bit version needed to be altered to 
skip unrecognized settings created from CONNECT. b) CONNECT needed to be modified to default missing 
parameters to match labeling behavior if run from the 32-bit version (previously, it defaulted to the most recently 
used parameters from the registry).  c) Text Style was missing from the 64-bit .ZLAB configuration file and has 
now been added.  (October 6, 2022 

 

DAT/EM Capture for Blue Marble Global Mapper 
Changes apply to Capture for Global Mapper. DAT/EM Capture for Global Mapper is supported for the following Global 
Mapper versions: 

• 17.1.2 – 24.0, up to the time of the DAT/EM v.8.1 build “Release” date. 

Notice: If you want to start using DAT/EM Capture for Global Mapper, please contact support@datem.com or your 
reseller for a quote for a Stacked Capture for Global Mapper. Starting in July 2020, DAT/EM installations will need a 
licensed Stacked Capture for Global Mapper, which will need a WriteLock to add it to an existing hardware lock. 

Advice for enabling and disabling the DAT/EM Capture extension for Blue Marble Global Mapper: 

DAT/EM Software installs the Global Mapper Extension, but leaves it unregistered in Global Mapper by default. 
To use the extension, close Global Mapper, select Windows Start > Datem Software group > right click on 
DAT/EM Administration Tool > More > Run as Administrator. Set CAD/GIS Package=Global Mapper, 
Action=Capture, Apply. Or, to disable at any time, set it to Action=Disable, Apply. 

 
To register/enable or unregister/disable, use the DAT/EM Administration Tool’s CAD Enabler 

Alternatively, you may toggle the extension from the Global Mapper > Help menu > License Manager. Note that 
it is correct to be called “DAT/EM Capture for Global Mapper 17 n-bit”. This file is the same for 17.x and higher 
matching the supported versions listed above. 

 

1. The Capture extension was verified to work with Global Mapper version 23.1.  (August, 2022) 

2. The Capture extension was verified to work with Global Mapper version 24.0.  (September 21, 2022) 

 

-End- 
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